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Instructor Notes Presentation: 90 Minutes



This module provides students with the knowledge and practical experience of using objects in scripts.



Lab: 45 Minutes



After completing this module, students will be able to: 



Understand how scripts use objects.







Understand object terminology.







Use an object browser.







Understand how scripts interact with the Component Object Model (COM).







Explain the use of various object models.



Materials and Preparation This section provides the materials and preparation tasks that you need to teach this module.



Required Materials To teach this module, you need the following materials: 



Microsoft® PowerPoint® file 2433A_02.ppt



Preparation Tasks To prepare for this module, you should: 



Read all of the materials for this module.







Complete the lab.
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Module Strategy Use the following strategy to present this module: 



Object Terminology This section introduces the students to the terms that they will encounter when programming with objects. It is essential that they understand all of the terms in this section, because much of the rest of the course uses objects. Spend as much time as necessary to make sure that the students understand the relationship between objects and their methods and properties. Also, ensure that the students fully understand the distinction between a class and an object. Use the analogies given in this section to help explain the terminology to students who have not encountered these terms before.







Creating and Using Objects This section reinforces the previous section by giving some examples of how objects can be used. Make use of the examples in the text and on the slides to expand the students’ understanding of how objects are created and used.







Understanding Object Models Explain that COM is a binary specification developed by Microsoft that makes the reuse of objects possible. Then, introduce the object browser and the object models described in this section. It is very important that the students understand the purpose of the two object models described in this section. They will use both the Microsoft Windows® Script Host (WSH) and the scripting object models in the lab. They will also work with these object models on an everyday basis at work.







Common Object Models Use this section to introduce some of the other object models that the students will find useful at work. You will not have time to go into any detail about these object models themselves. Also, note that some of the object models are covered in more detail later in the course. Use this section as an introduction to these object models.
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Customization Information This section identifies the lab setup requirements for a module and the configuration changes that occur on student computers during the labs. This information is provided to assist you in replicating or customizing Training and Certification courseware. Important The lab in this module is also dependent on the classroom configuration that is specified in the Customization Information section at the end of the Classroom Setup Guide for course 2433A, Microsoft Visual Basic Scripting Edition and Microsoft Windows Script Host Essentials.



Lab Setup There are no lab setup requirements that affect replication or customization.
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Overview Topic Objective



To provide an overview of the module topics and objectives.



Lead-in



In this module, you will learn about objects and how they are used in scripts.







Object Terminology







Creating and Using Objects







Understanding Object Models







Common Object Models



*****************************ILLEGAL FOR NON-TRAINER USE***************************** Understanding objects is fundamental to the script writing process. This module describes what an object is, and how you can use them in scripts. At the end of this module, you will be able to: 



Understand how scripts use objects.







Understand object terminology.







Use an object browser.







Understand how scripts interact with the Component Object Model (COM).







Explain the use of various object models.
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 Object Terminology Topic Objective



To introduce object terminology.



Lead-in



Using objects in your scripts will afford you many advantages.







Understanding Object Terminology







Methods and Properties







Understanding Instantiation Terminology



*****************************ILLEGAL FOR NON-TRAINER USE***************************** Using objects in your scripts gives you many advantages, such as efficiency, reliability, and reuse of existing functionality. Before you can use objects in your scripts, you must understand the terms and concepts applicable to programming with objects. This section describes the terminology used when programming with objects. It also includes an analogy that helps to summarize the key concepts introduced in this section.
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Understanding Object Terminology Topic Objective



To introduce object programming terms.



Lead-in



This is a list of terms that you will come across when working with scripts.







Objects 







Packaged functionality



Compiled Objects



*****************************ILLEGAL FOR NON-TRAINER USE***************************** You will encounter some terminology as you start to use objects in your scripts. Each term has a distinct meaning. You will come across these terms frequently. Each term, and how they relate to each other, is described below.



Objects Objects are packaged pieces of functionality. Objects contain code that you can use in your scripts. However, the manner in which you access the functionality contained in an object is called black-box reuse. When you use the functionality provided by an object, you never need to see the code that it contains.



Compiled Objects The most common types of objects that you will use in your Microsoft® Visual Basic® Scripting Edition (VBScrpt) files are compiled objects. With these types of objects, you will never need to see the code that they contain. The code that provides the functionality is compiled into a binary file, which is usually a dynamic link library (DLL) or a Microsoft ActiveX® Control file (with the file extension .ocx). All that you need to do is create script in VBScript that communicates with the object to reuse the prepackaged functionality that it provides. In addition to containing code that provides reusable functionality, objects also contain data. You can manipulate this data in a manner similar to reusing the packaged functionality. You do not need to know how the object implements its data. You only need to know how to communicate with the object to manipulate the data values. Again, this is all part of the black-box reuse concept. You will communicate with the functionality provided by an object by using its methods. You will manipulate the data that an object contains by working with its properties. Methods and properties are described in the following section.
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Note Each object that you work with has a well-defined list of methods and properties associated with it. For example, one object might contain a Color property and a Paint method, while another object might contain a Name property and a Play method. The methods and properties that each individual object contains are designed by the developer of that object.
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Methods and Properties Topic Objective



To explain methods and properties.



Lead-in







Methods



To manipulate objects, you work with their methods and properties. 







Invoking a method







Using parentheses



Properties



*****************************ILLEGAL FOR NON-TRAINER USE***************************** To manipulate objects, you work with their methods and properties.



Methods Objects expose their functionality as methods. To use the functionality provided by a particular method, you need to know how to call it. You do not need to know how the method works internally. The term invoke is often used to describe the process of calling a method. When you invoke a method in your script, the compiled method code runs in its entirety at the point in your code where you call it. It is important to understand the benefits that this affords you as a script developer. The method might contain thousands of lines of code hidden from you by the object. You can simply access this code by calling the method. You can achieve this by using a single line of script. The term used to describe the approach of hiding complex code is encapsulation.



Invoking a method There are three different ways to invoke a method. Which approach you use in your script depends upon how the method is exposed. The three approaches are described below. Syntax



Object.Method



In this approach, the method is invoked with a simple call. The call uses the dot notation to specify the name of the object and the name of the method that you want to invoke. In this simple call, the method does not need any inputs from your script, nor does it return data to your script.
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Syntax



Module 2: Working with Objects Object.Method Param1 [, Param2, … ,Paramn]



In this approach, the method is invoked with a call similar to the previous call. Again, the call uses the dot notation to specify the name of the object and then the name of the method that you want to invoke. However, this approach passes data into the method from your script by using one or more parameters. The method accepts the data and works with it internally, encapsulated from your script. The parameters are provided as a comma-separated list. Syntax



MyVariable = Object.Method([Param1, Param2, … ,Paramn])



In this approach, a Visual Basic Scripting Edition variable is used to hold the return value of the method call. Again, the dot notation is used, but this time the value of the variable is set to the result of the method call. Note For more information about variables, see Using Objects later in this module and in Module 3, “Script Logic,” in Course 2433A, Microsoft Visual Basic Scripting Edition and Microsoft Windows Script Host Essentials.



Using Parentheses An important addition to this syntax is the inclusion of the parentheses that follow the method call. The parentheses indicate that your script must evaluate the method call. In this case, it holds the evaluated data in the variable. Methods that return data to the calling script might require parameters. If this is the case, then those parameters must be supplied as a comma-separated list inside the parentheses, as shown in the previous syntax. However, some methods might return data and not require parameters. If this is the case, then you still must use the parentheses, although the code does not contain any parameters, as the following syntax illustrates: Syntax



MyVariable = Object.Method()



Properties Objects expose their data to your script in their properties. To manipulate this data, all you must know is how to retrieve and set the property value. You do not need to know how the object actually stores or handles the data. Again, this reinforces the black-box reuse concept. The following syntax illustrates some standard approaches to setting and retrieving the values of an object’s properties:
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Object.Property = Value



In this syntax, using the dot notation sets the property's value. The value might take one of a number of forms, but you must be able to evaluate it as a discrete value. Some of forms that the value takes are described as follows: 



A literal value You can set the property of an object to a literal value, such as the number 10 or the string “Cat.”







A simple expression that can be evaluated as a discrete value You can set the property of an object to the result of an expression that your script can evaluate as it runs, such as the result of 18 + 9 or the result “London” concatenated with “ United Kingdom.”







A property of another object You can set the property of one object to the property of another object. You can achieve this in the following single line of code:



Syntax



Object1.Property1 = Object2.Property2 



The return value of an object’s method call You can set the property of one object to the return value of another object’s method. You can achieve this in the following single line of code:



Syntax



Object1.Property1 = Object2.Method([Param1])



If you want to retrieve the property value and store it in one of your variables, use the following code. The syntax is very similar to that used to retrieve the return value of a method. However, in this case, you do not use parentheses. Syntax



MyVariable = Object.Property
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Understanding Instantiation Terminology Topic Objective



To describe Instantiation terminology.



Lead-in



To use objects and their corresponding methods and properties, you must write code that creates the object.







Classes Blueprints for your objects







An Analogy–Architect Drawings and Buildings







Type Libraries 







A collection of classes



Instantiation 



Multiple instances



*****************************ILLEGAL FOR NON-TRAINER USE***************************** To use objects and their corresponding methods and properties, you must write code that creates the object. Object creation involves referring to the object’s type library and class. These terms are explained below.



Classes A class is the blueprint for an object. The developers who allow you to reuse their code as objects do not write the code in the object itself. They actually write code in a class. When you want to reuse code, your script creates an object based on a class. The object code is written in the class in such a way that it provides you with the methods and properties for your object.



An Analogy–Architect Drawings and Buildings One way to think about the purpose of a class is to consider a real-world analogy. Imagine the process involved in planning and constructing a building: The architect has a vision of what she wants the building to look like and how she wants the building to be structured. To convey her ideas to the builders, she creates an architect drawing, or blueprint, in which she specifies the materials to be used and the dimensions of the building. At this point, her job is done. She can now hand the blueprint to the builders, who construct the building according to the plans. In fact, the builders can construct many similar buildings, all based on the same drawing. They can reuse the blueprint many times. After the building has been constructed, the owner can decide to paint the building with a color of his choice. He might also decide to install alarms, add furniture, and so on. In this analogy, the architect’s blueprint is analogous to a class. Objects are analogous to the buildings that are created from the blueprint.



Module 2: Working with Objects



9



The blueprint makes allowances that alarms can be installed and furniture can be added. These actions are analogous to methods. The object is manipulated after it has been created by performing these actions. Furthermore, the blueprint of the building does not specify a fixed color for the paint used to decorate it. The blueprint allows this color to be chosen after the building has been constructed. The paint color is analogous to a property.



Type Libraries A type library is a collection of classes that can be redistributed to allow you to build objects based on those classes. Type libraries are compiled files that expose their classes to your script. They are usually compiled into dynamic link libraries (DLL) or ActiveX Controls files.



A Collection of Classes Using the earlier analogy of a blueprint, the architect might produce many blueprints for different building types. She might develop one blueprint for a house, one for an apartment building, and one for a skyscraper office complex. She might then store all of these blueprints in a folder that is named Buildings. When she completes these blueprints, she can give the whole folder to the builder. When the builders want to build a house, they can get the house blueprint from the folder. They could also access the skyscraper or apartment blueprints to construct those types of buildings, as well. In this analogy, the folder is the type library. It contains the blueprints for many different types of buildings. Each building type has its own set of distinct features and attributes. In object terminology, the methods and properties are these distinct features and attributes. You must know the name of any type library that you use in your scripts. Note For examples of the names of type libraries, see Working with Objects later in this module.



Instantiation The process of creating an object from its class is termed instantiation. When an object is instantiated, it inherits the properties and methods that the class defines. This functionality is held in memory by your computer. As a result, it is efficient for you to manipulate the object. After the object is instantiated, it no longer needs to refer back to its class, nor is it desirable that it should do so. The premise behind this fact is that after the object is created, you can manipulate it without affecting the class upon which the object was based. Using the architect drawing analogy, imagine that the builders have constructed a house and that the decorator paints it yellow. It is sensible that this action should affect only that house and should not affect the blueprint. If it does affect the blueprint, then all of the new houses would now be yellow, which is obviously not desirable.
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Multiple Instances You will often use multiple instances of the same class in your script. If you create multiple instances of the same class, then you can manipulate each instance, or object, independently of the others. Using the above analogy, the builders might construct a whole street of houses from the same blueprint. The decorator might then paint house Number 1 yellow. This will not affect the other houses, even though they are based on the same blueprint. The decorator might paint house Number 2 green, and so on. Note Objects are usually instantiated with a single line of code written in Visual Basic Scripting Edition. For more information about how to write this instantiation code, see Creating and Using Objects later in this module.



Module 2: Working with Objects



11



 Creating and Using Objects Topic Objective



To explain how to use objects within a script.



Lead-in



Now that you understand what an object is, let’s look at how you can use them in scripts.







Creating Objects







Using Objects



*****************************ILLEGAL FOR NON-TRAINER USE***************************** Once you understand the programming terms that relate to objects, you can use objects in your scripts. This section explains how to create and use objects in your scripts.
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Creating Objects Topic Objective



To explain how to create objects.



Lead-in



The type library that Windows Script Host uses is Wshom.ocx.







Libraries 







Classes 







Example-Wshom.ocx Example-WScript.Network



Object Usage Example



Dim Dim oNetwork oNetwork Set Set oNetwork oNetwork == CreateObject(“WScript.Network”) CreateObject(“WScript.Network”) oNetwork.MapNetworkDrive oNetwork.MapNetworkDrive "z:", "z:", \\London\Lab2Share \\London\Lab2Share



*****************************ILLEGAL FOR NON-TRAINER USE***************************** A type library commonly used by administrative scripts is the Microsoft Windows Script Host (WSH) library.



Libraries The WSH library is distributed in the Wshom.ocx file, and is installed by default on all Microsoft Windows 2000 computers. This type library is accessed in a script that uses the following name: Example



WScript



Classes The WScript type library contains multiple classes that you use in your scripts. An example is the Network object. This allows a script to perform simple network tasks. The object is instantiated using the following syntax: Syntax



Set = CreateObject(".")



An example of how to create the Network object is as follows: Example



Set oNetwork = CreateObject("WScript.Network")



The above syntax uses the CreateObject() function that is part of the Visual Basic Scripting Edition language. It accepts a string parameter that specifies the type library and the class to be used to create the object. An object variable is set to the result of this function so that you can then use the variable to refer to the newly created object in subsequent lines of script. Note For more about object variables, see Using Objects later in this module.
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After this object has been instantiated, you can use the object to perform network tasks, such as mapping a network drive or printer. This is achieved by using methods, such as MapNetworkDrive and AddPrinterConnection. The oNetwork object variable also exposes properties such as ComputerName and UserName, which you can use in the script to identify the user running the script and the computer that it is running on. The following example illustrates how you can use these methods and properties: Example



Set oNetwork = CreateObject("WScript.Network") oNetwork.MapNetworkDrive "Z:", "\\MyServer\MyShare" Wscript.Echo oNetwork.ComputerName



The first line of code instantiates the new object and sets the oNetwork object variable to it. The next line of code uses the MapNetworkDrive method to create a new drive mapping. The parameters supplied indicate that the Z drive is to be mapped to the shared folder called MyShare on the server called MyServer. The third line of script retrieves the value of the ComputerName property from the oNetwork object variable. In the same line of code, the result of this operation is displayed to the user with the Echo method of the built-in WScript object. Note Although WScript is the name of a type library, there is also an object called WScript that exposes useful methods like Echo. Since this object is related to the host itself, there is no need to instantiate it (as you must do with most objects). It is automatically instantiated by the host that your scripts run in and can therefore be used directly.
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Using Objects Topic Objective



To explain how you can create and use objects in scripts.



Lead-in



When you want to use an object in a script, you must first create the object by using the set statement.







Assigning an Object to a Variable



Set Set objFSO objFSO == CreateObject("Scripting.FileSystemObject") CreateObject("Scripting.FileSystemObject") 



Using an Object



objFSO.CreateFolder("C:\Test") objFSO.CreateFolder("C:\Test") 



Deleting an Object



Set Set objFSO objFSO == Nothing Nothing



*****************************ILLEGAL FOR NON-TRAINER USE***************************** To use the properties and methods of an object, you must be able to refer consistently to your instance of it. To do this, you use a named pointer to your instance of the object. The named pointer is known as an object variable, and it points to the object code and data in memory.



Assigning an Object to a Variable You will use the set keyword to assign an object to a variable in your code. The set keyword informs the script that the variable points to an in-memory object structure. The following example instantiates a FileSystemObject object and points the objFSO variable to it, so that it can be manipulated in subsequent lines of code: Example



Set objFSO = CreateObject ("Scripting.FileSystemObject")



Using an Object After the object has been created in the memory space of the running script, it is possible to access the methods and properties that it exposes by using the object variable that points to it. The following example uses the CreateFolder method to create a new folder called Test in the root of the C drive: Example



objFSO.CreateFolder ("C:\Test")
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Deleting an Object Objects consume memory on the computer that they are running on. Therefore, it is good practice to delete them when you are done using them. To delete an object, you set its object variable to the keyword Nothing, as shown in the following: Example



Set objFSO = Nothing



Note Objects that are not explicitly set to Nothing are deleted automatically by WSH when the script terminates. However, it is considered best practice to delete objects explicitly when the script no longer requires them, because this frees up the disk space that is used by the object. Complex objects can use a substantial amount of disk space, so you should delete complex objects as soon as possible.
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 Understanding Object Models Topic Objective



To introduce the concept of object models.



Lead-in



This section introduces the concept of object models. You will see how this information can help you write scripts.







Defining Object Models







COM Objects







COM Objects in Practice







Using an Object Browser







Demonstration: Using an Object Browser







The Scripting Object Model







The WSH Object Model



*****************************ILLEGAL FOR NON-TRAINER USE***************************** An object model describes a collection of objects that are designed to perform a related set of tasks. This section examines how these models function and how you can use them when you are writing scripts. This section also provides an introduction to the Component Object Model (COM). In addition, you will learn more about the Microsoft Scripting runtime object model and the WSH object model. An understanding of these object models increases the range of administrative tasks that you will be able to perform with scripts.
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Defining Object Models Topic Objective



To explain the concept of an object model.



Lead-in



An object model describes a collection of objects that are designed to perform a related set of tasks.







Describing Object Models







Examples of Object Models 



WSH







ADSI







ADO



*****************************ILLEGAL FOR NON-TRAINER USE***************************** Many of the objects that you will use in your scripts are presented to you in an object model.



Describing Object Models An object model is a collection of objects that are designed to perform a related set of tasks, such as managing the file system or reading information from a database. The object classes, methods, and properties are grouped together by the developer and presented as an object model. In many cases, the objects in the object model are organized into a hierarchy. The higher level, or root, objects provide access to the objects further down. For example, the FileSystemObject object provides access to the drive object. It is not possible to call the drive object without using the FileSystemObject object. While many existing object models implement hierarchies that require you to access one object through another object, a more modern approach is to access all objects directly. For example, all of the objects in the ActiveX Data Objects (ADO) model can be accessed directly. They are not organized into a hierarchy.
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Examples of Object Models Some of the most commonly used object models in administrative scripts are described below: 



Windows Script Host (WSH) This object model provides you with functionality that you can use to perform basic administrative tasks, such as creating folders and mapping network drives.







Active Directory™ Service Interface (ADSI) This object model provides you with functionality that you can use to access and configure the Active Directory service features, such as users and groups.







ActiveX Data Objects (ADO) This object model provides you with functionality that you can use to access data sources, such as Microsoft SQL Server™.
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COM Objects Topic Objective



To introduce the concept of COM objects.



Lead-in



Data Marshalling



WScript



The Component Object Model provides a set of rules that defines how software can be made of reusable components.



Contract What Can You Do? This is What I Can Do...



VBScript



*****************************ILLEGAL FOR NON-TRAINER USE***************************** The Component Object Model (COM) provides a specification and set of rules that define how software systems can be constructed from reusable components. The COM specification also describes the precise way in which clients, such as WSH scripts, can communicate with objects that are located inside components.



Contracts A contract consists of a definition of the methods and properties supported by objects. COM allows a contract to be defined and specifies the services that the component provides to its clients. The rules of COM mandate that the contract, after it is published or made generally available to client software, cannot change. This alleviates many of the versioning issues prevalent in most software systems, particularly those developed prior to the component era. COM also governs how data is transferred between the client and object. The process of passing data into and out of an object is called marshalling.



DCOM and Component Services Distributed COM (DCOM) extends marshalling support of COM so that objects can be accessed over a network. Windows 2000 integrates Component Services to provide additional functionality to component developers and support for distributed transactions, resource management, security, and so on.
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COM Objects in Practice Topic Objective



To describe COM objects in practice.



Lead-in



To identify classes, a ProgID is used. These identifiers specify what the class is and what type library it belongs to.







Object Identification 







Automation 







ProgID Required for script



Type Libraries 



Defines component's metadata



*****************************ILLEGAL FOR NON-TRAINER USE***************************** Classes are identified by using a label called a Programmatic Identifier, or ProgID.



Object Identification The ProgID is stored in the HKEY_CLASSES_ROOT section of the registry. It tells the system which .dll, .exe, or .ocx file contains the associated class definition that is used to construct the object. A ProgID consists of a type library and a class name that are separated by a dot, as in the following example: Syntax



Library.Class



The following example uses the Scripting.FileSystemObject ProgID to create an instance of the object. The registry contains information about the compiled file that defines this type of object: Example



Set MyObject = CreateObject("Scripting.FileSystemObject")



Automation Scripting environments, such as WSH, impose certain restrictions on COM objects. One of the key restrictions is the range of data types that can be passed to and from the object. This, and other restrictions, means that script code cannot communicate with all COM objects. Those COM objects complying with the requirements of script are called automation objects. Automation defines a restricted set of data types and imposes one or two other requirements on the developer of COM objects. From the administrator’s perspective, this is not a significant issue, since nearly all of the object models that an administrator might want to use from a WSH script are automationcompliant.
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For example, all of the applications in Microsoft Office, such as Microsoft Word and Microsoft PowerPoint®, support automation. As a result, Visual Basic Scripting Edition can be used to control their functionality. The following script takes the first slide from an active PowerPoint presentation, copies it, and pastes it into a Word document called Demo.doc that is located in the C:\My Documents\ folder: Example



Set oPres = CreateObject ("PowerPoint.Application") oPres.Visible=True oPres.ActivePresentation.Slides(1).Copy Set oWord = CreateObject ("Word.Application") oWord.Visible=True oWord.Documents.Open "c:\My Documents\Demo.doc" oWord.Selection.Range.Paste



Type Libraries As mentioned previously, you can use type libraries to define the set of classes, methods, and properties that a component supports. This type of information is the component’s metadata, the data that describes data. Although it is typically saved as part of the component’s .dll or .ocx file, it can reside in a stand-alone type library file, usually with a .tlb file extension. By examining the metadata inside a type library, it is possible to discover the objects, methods, and properties that you can use in a script. Object browsers can use this type information to depict a graphical view of an object model.
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Using an Object Browser Topic Objective



To demonstrate how to use an object browser.



Lead-in



When you write scripts, it is useful to view what objects are available to you in a type library.







Accessing Type Libraries







Reviewing Class Information



*****************************ILLEGAL FOR NON-TRAINER USE***************************** It is helpful to view what objects are available in a type library when you write script. Many tools can give you this functionality. The Microsoft Object Browser is a tool that you can use to look inside a type library. It displays the information in a readable, graphical form. The object browser ships with Microsoft Visual Basic for Applications in Microsoft Office. Note Another browser tool called the object linking and embedding (OLE)/COM Object Viewer ships with Microsoft Visual Studio® development system. It is a developer-oriented tool and will not be used in this course. You can download it as a stand-alone application from the Microsoft Web site at www.microsoft.com.
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Demonstration: Using an Object Browser Topic Objective



To demonstrate how to use an object browser.



Lead-in



In this demonstration, you will see how to use an object browser.



*****************************ILLEGAL FOR NON-TRAINER USE***************************** In this demonstration, you will see how to use an object browser.



 To use an object browser to view an object model 1. Click Start, point to Programs, and then click Microsoft Word. 2. In the Microsoft Word window, on the Tools menu, point to Macro, and then click Visual Basic Editor. 3. In the Microsoft Visual Basic window, on the View menu, click Object Browser. 4. Click the list. The libraries available to Microsoft Word are the following: • Normal • Office • stdole • VBA • Word



24



Module 2: Working with Objects



 To add the Scripting library 1. In the Microsoft Visual Basic window, on the Tools menu, click References. 2. In the References–Project dialog box, select the Microsoft Scripting Runtime check box, and then click OK. 3. Click the list. Note that Scripting library has been added to the list. 4. Click Scripting. 5. In the empty list, type FileSystemObject and then press ENTER. 6. In the Members of ‘FileSystemObject’ pane, click CreateFolder. Notice the data in the Search Results pane as you click the item. 7. Close the Microsoft Visual Basic window. 8. Close the Microsoft Word window.
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The Scripting Object Model Topic Objective



To introduce the scripting object model.



FileSystemObject Drives Drives



Lead-in



The primary object provided by the scripting object model is the FileSystemObject object. This object allows the administrator to manage the files and folders on a computer.



Drive Dictionary



Folders Folders Folder



Encoder



Files Files File TextStream



*****************************ILLEGAL FOR NON-TRAINER USE***************************** The type information describing the scripting object model, or the Microsoft Scripting Runtime object model, is defined in Scrrun.dll. The primary object that this object model provides is the FileSystemObject object. You will sometimes use the Dictionary object and the Encoder object from this object model.



FileSystemObject You can use the FileSystemObject object to manage files and folders on the local computer. In addition to manipulating existing folders and files, the FileSystemObject object enables you to create new folders and text files. You can only create text files by using the FileSystemObject object. If you want to create a new Word document, you must use the Word object model. The FileSystemObject object also does not provide support for managing NTFS file systems permissions. If you need to change the security permissions on the file, you must use an extra utility.



Dictionary The Dictionary object is a container object that you can use to store arbitrary items of data. You associate each item with a name or unique key value. You can use the key to retrieve the stored data. For example, you can use the Dictionary object to store the details about all of the administrators in an enterprise. Details might include a name, phone number, and e-mail address. You can associate each dictionary entry with the unique site the administrator is responsible for. The site in the following example acts as the key with which the data item can be retrieved. It uses the Dictionary object. The example creates an instance of the Dictionary object and then stores the details of three administrators, Alan, Kathie, and Don, in it.
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Example



Module 2: Working with Objects Set AdminsList AdminsList.Add AdminsList.Add AdminsList.Add



= Wscript.CreateObject("Scripting.Dictionary") "UK", "Alan : +44 (0)117 555-0100" "Europe", "Kathie : +33 (0)122 555-0105" "US", "Don : +1 (0)25 555-0115"



To display, for example, the details about the administrator who is responsible for the UK, use the following line of code. This line of script uses the associative feature of the Dictionary object to retrieve the detail about the UK administrator. The retrieved data is then concatenated with a string literal and displayed by using the WScript.Echo method. Example



WScript.Echo "The UK administrator is: " & AdminsList("UK")



Encoder Scripts that have been encoded use the Encoder object. The encoding process is done with the Windows Encoder utility. This enables script writers to encode their script so that the script cannot be viewed, copied, or modified but can still be executed.
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The WSH Object Model Topic Objective



To introduce the WSH object model.



WScript



Arguments Arguments



Shell



SpecialFolders SpecialFolders



Lead-in



The WSH object model provides some of the most commonly used objects in scripting.



Shortcut UrlShortcut Environment



Network



= Intrinsic Object



*****************************ILLEGAL FOR NON-TRAINER USE***************************** The type library Wshom.ocx provides the object model for WSH. This object model provides some of the objects, methods, and properties that are most often used in scripting.



WScript The WScript object is an intrinsic object, which means that it is automatically created when a script is executed and requires no explicit instantiation. The WScript object supports the following methods: 



CreateObject. This enables the creation of an object for use in the script.



Note The WScript CreateObject method is accessed by using the following ProgID: WScript.CreateObject(“”). If the “Wscript” is left out, the Visual Basic Scripting Edition CreateObject method is used. For most standard actions, both methods are interchangeable. 



ConnectObject. This connects WSH to an existing object.







DisconnectObject. This disconnects WSH from an existing object connected by ConnectObject.







GetObject. This enables the retrieval of an existing object from a file, for example the opening of an existing Word document.







Echo. This is used to display a message on the screen, either by a command line if the host is CScript or by a message box if the host is WScript.







Quit. This terminates the execution of the script.







Sleep. This causes the script execution to pause for the stated number of milliseconds. This can very useful when sending keystrokes to an external program from a script.
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Shell This object is instantiated with the following statement: Example



Set objShell = WScript.CreateObject("WScript.Shell")



You can use this object to start a new process, create shortcuts, and provide the environment collection to handle access to useful environmental variables, such as WINDIR, COMPUTERNAME, and USERNAME. This is done by using the following objects: 



SpecialFolders. Returns the paths for Windows shell folders such as the Desktop folder, Start menu folder, and personal My Documents folder.







Shortcut. Creates an object reference to a shortcut.







UrlShortcut. Creates an object reference to a Uniform Resource Locator (URL) shortcut.







Environment. Retrieves environment variables from the operating system.



Network This object is instantiated with the following statement: Example



Set objNetwork = WScript.CreateObject( "WScript.Network" )



The Network object exposes the Microsoft Windows network functionality to your scripts, which provides methods that you can use to: 



List all mapped drives.







Connect and disconnect remote drives.







List all mapped printers.







Connect and disconnect remote printers.







Set the default printer.
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 Common Object Models Topic Objective



To introduce some common object models.



Lead-in



Now that you have seen the basic object models, it is time to look at some automation object models that can be used in scripts.







Collaboration Data Objects







ActiveX Data Objects







Active Directory Service Interfaces







Windows Management Instrumentation







Internet Explorer and Internet Information Server







Other Applications



*****************************ILLEGAL FOR NON-TRAINER USE***************************** The object models discussed so far provide the basic functionality that you can use to write useful administrative scripts. In this section, you will be introduced to some of the other automation object models that you can use for specific tasks, such as sending e-mail messages and accessing databases.



30



Module 2: Working with Objects



Collaboration Data Objects Topic Objective



To introduce CDO.



Lead-in



CDO is an object model that allows scripts to use messaging functions, such as sending an e-mail message or checking a recipient’s e-mail address.







CDO Names







CDO Library Versions



*****************************ILLEGAL FOR NON-TRAINER USE***************************** Collaboration Data Objects (CDO) are designed to simplify the creation of applications or scripts with e-mail messaging functionality. The CDO libraries expose messaging objects, such as folders, messages, recipient addresses, and attachments.



CDO Names CDO has gone through the following name changes in its lifetime: 



Previous versions of CDO were called OLE Messaging. OLE Messaging was first available in Exchange version 4.0.







CDO version 1.1 was named Active Messaging. Active Messaging was installed with Exchange version 5.0. There were a few feature enhancements in Active Messaging, but the core functionality of the library remained unaltered.







The current version 1.2 has the name Collaboration Data Objects (CDO). CDO 1.2 is installed with Exchange version 5.5. This version has added functionality over CDO 1.1, including support for scheduling meetings and appointments.



Note To download CDO version 1.21, go to http://www.microsoft.com/exchange/55/downloads/cdo.htm
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CDO Library Versions The following four versions of the CDO library are available: 



CDO version 1.2.1 (Cdo.dll). This version is installed with Microsoft Outlook® 98, Outlook 2000, and Exchange 5.5 Server. It can be used on all Windows platforms, and it uses Messaging Application Programming Interface (MAPI) to perform its tasks.







CDONTS (Cdonts.dll). CDO for NT Server is installed with Internet Information Services (IIS), Microsoft Commercial Internet Server (MCIS) and Exchange 5.5 Server. It uses Simple Mail Transfer Protocol (SMTP) and is designed for use by IIS applications. It does not support user interfaces, such as profile dialogs. Also, it does not use MAPI and therefore has no concept of Address Books, Authenticated Users or other MAPI features.







CDO For Windows 2000 (Cdosys.dll). CDO 2.0 ships with Windows 2000 platforms. It supports SMTP and Network News Transfer Protocol (NNTP) but does not support MAPI. It is designed for administrators, because it enables you to do the following: • Append disclaimers or other notices to e-mail messages sent through a server. • Create Active Server Pages (ASP) applications with messaging capabilities. • Detect and discard unsolicited bulk mailings. • Detect and discard inappropriate newsgroup postings. • Check incoming messages for viruses. • Forward and filter messages automatically.







CDO for Exchange 2000 (Cdoex.dll). The latest version is CDO version 3.0 for Exchange 2000. This is installed with Exchange 2000 Server. CDOEX upgrades the features of CDO for Windows 2000 to include features such as calendar objects and contact management and support for the new Exchange 2000 Web Storage System.
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ActiveX Data Objects Topic Objective



To introduce ADO.



Lead-in



ADO is an object model that is used to access data from a data source, such as a relational database.







Data Sources







Examples of Data Providers: 



ODBC







Index Server







SQL Server







Active Directory directory service







Exchange 2000



*****************************ILLEGAL FOR NON-TRAINER USE***************************** ActiveX Data Objects (ADO) enables the fast and efficient access to and manipulation of data in a data source.



Data Sources Data sources are often relational databases, such as SQL Server 2000. However, ADO enables you to access a variety of other nonrelational data sources, such as Active Directory. You can use ADO to search Active Directory for objects and properties, such as users and phone numbers. Because it enables you to search Active Directory, ADO is of interest to administrators who write scripts. Note The current ADO provider for ADSI only provides read-only access to objects in Active Directory.



Examples of Database Providers To access data that is stored in different formats, ADO requires an OLE database (DB) provider for each type of data source. The current ADO OLE DB providers include: 



Open Database Connectivity (ODBC), for databases without a specific OLE DB provider







Microsoft Index Server







SQL Server







Active Directory directory service







Exchange 2000
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The ADO model consists of the following objects: 



Connection. Represents a connection to an OLE DB data source such as ADSI.







Command. Defines a specific command to execute against the data source.







Error. Contains details about data access errors and is refreshed each time that an error occurs in a single operation.







RecordSet. Represents the results of a command object execution and consists of a sequence of records.







Fields. Represents the collection of fields or columns within a record set.







Parameters. Represents a collection of parameters, which can be supplied to the command object to modify its execution.







Properties. Represents values supplied by the provider for a data source.



Note For more information about how to use ADO to search for information in Active Directory, see Module 5, “Understanding ADSI,” in Course 2433A, Microsoft Visual Basic Scripting Edition and Microsoft Windows Script Host Essentials.
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Active Directory Service Interfaces Topic Objective



To introduce ADSI.



Lead-in



ADSI enables you to read and write data within directory services, such as Active Directory.







Active Directory Service Interface







Gives Access to Multiple Directory Service Providers Through an Open Set of Interfaces







ADSI Providers Include: 



LDAP







Windows NT







NDS







NetWare 3 bindery



*****************************ILLEGAL FOR NON-TRAINER USE***************************** Active Directory Service Interface (ADSI), previously called OLE Directory Services, gives developers and administrators access to the information stored within multiple directory service providers through an open set of interfaces. Applications or scripts, written by using ADSI, work with any directory service that has an ADSI provider. For example, with ADSI, scripts can access Lightweight Directory Access Protocol (LDAP), Novell Directory Services (NDS), Active Directory, and Microsoft Windows NT® version 4.0–based directories with a single interface. The only prerequisite for accessing these types of directory structures is that there is an appropriate ADSI provider available. Examples of available ADSI providers include: 



LDAP The LDAP provider works with any LDAP version 2 or version 3 directory, such as Exchange 5.0 and 5.5. This provider is also used to provide the access to Active Directory.







Windows NT (WinNT) The WinNT provider supports the Windows NT 4.0 directory and serverbased objects such as the Lanman Server.







NDS This provider gives you access to the Novell Directory Service.







NetWare 3 bindery (NWCOMPAT) This provider gives access to Novell’s legacy bindery (3.x) servers.



ADSI compatible products include Active Directory, Exchange 5.5, IIS, and Site Server. Note You will learn more about ADSI in Module 5, “Understanding ADSI”.
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Windows Management Instrumentation Topic Objective



To introduce WMI.



Lead-in



WMI is the Microsoft implementation of a standards-based management API.







Web-Based Enterprise Management 







Standard management API



Windows Management Instrumentation 



Can monitor and configure the Windows operating system, system devices, Active Directory, the registry, performance counters, and so on







Execute methods on managed objects







Receive event notification



*****************************ILLEGAL FOR NON-TRAINER USE***************************** Windows Management Instrumentation (WMI) is a single, consistent application programming interface (API) that is designed to make the Windows 2000 server family the most manageable Microsoft operating system to date.



Web-Based Enterprise Management (WBEM) WBEM is an industry initiative to develop a standard technology for accessing management information in an enterprise. The aim is to lower the total cost of ownership (TCO) of computers in an enterprise. Many companies are participating in the WBEM initiative.
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Windows Management Instrumentation (WMI) WMI is the Microsoft implementation of WBEM. WMI can be used to write management scripts by using a single, object-oriented, remote-enabled, and scriptable interface that provides the following functionalities: 



Monitor, configure, and control management information about: • The Windows operating system. • System devices. • Active Directory. • The registry. • Performance counters.







Execute methods on managed objects to perform complex operations; for example, to compress a file or reboot a remote system.







Receive and act on events based on changes in any management data visible through WMI and events from Simple Network Management Protocol (SNMP) devices and the Windows Event Viewer service.



Note This level of functionality makes WMI complex to script. WMI scripting is a major topic on its own and falls outside the scope of this course. For more information about WMI scripting, see Module 8, “Beyond the Basics” in Course 2433A, Microsoft Visual Basic Scripting Edition and Microsoft Windows Script Host Essentials. For more information about WMI in general, go to the following Web site and download the WMI software development kit (SDK): http://msdn.microsoft.com/downloads/c-frame.htm?007#/downloads/sdks.
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Internet Explorer and Internet Information Server Topic Objective



To introduce scripting in Internet Explorer and IIS. 



Lead-in



Visual Basic Scripting Edition and JScript can be used within Internet Explorer and IIS, because Internet Explorer and IIS are script hosts.







Internet Explorer 



Script host







No access to WSH



Internet Information Server (IIS) 



Active Server Pages



*****************************ILLEGAL FOR NON-TRAINER USE***************************** Prior to WSH, the primary application for Visual Basic Scripting Edition and Microsoft JScript® was for Web scripting.



Internet Explorer Since Microsoft Internet Explorer version 3.0, Internet Explorer has had a scripting host embedded in it. Due to this historical link with the Web browser, a great deal of VBScript documentation still assumes that you are using script only in the context of a Web browser. This may be misleading for systems administrators, because the functionality provided by WSH could be very different to that provided by Internet Explorer. For example, the functionality of the Internet Explorer host has been limited for security reasons, because it is not desirable if a remote Web script can access the FileSystemObject object and delete files or folders.



IIS IIS has the ability to run VBScript if this script is embedded in an Active Server Page (ASP). Unlike Internet Explorer, the ASP page has full access to WSH, because the script is being run only on the server. As a result, ASP pages can be used very successfully to provide a central management Web site that administrators can use to manage an enterprise. Note For more information about the administrative use of ASP pages, see Module 8, “Beyond the Basics,” in Course 2433A, Microsoft Visual Basic Scripting Edition and Microsoft Windows Script Host Essentials.
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Other Applications Topic Objective



To introduce the use of scripting in other applications.







Lead-in



Because many applications expose their own COM interface, can control them through the use of script.



Microsoft Office 







Microsoft Word, Microsoft Excel, Microsoft PowerPoint, Microsoft Access, Microsoft Outlook, and Microsoft FrontPage



Utilities 



Example: Windows Media Player



*****************************ILLEGAL FOR NON-TRAINER USE***************************** Many applications and utilities expose a COM automation interface. This makes scripted control of the application possible.



Microsoft Office It is possible to control Microsoft Word, Microsoft Excel, Microsoft PowerPoint®, Microsoft Access, Microsoft Outlook, and Microsoft FrontPage® with script. A comprehensive help file is included with Microsoft Office to help you understand the many possibilities involved in scripting these applications. The help file is aimed at Visual Basic and Web developers, so some experimentation with different versions of the examples might be needed to make them work with WSH. Note For examples of scripting with Microsoft Office, see Module 8, “Beyond the Basics,” in Course 2433A, Microsoft Visual Basic Scripting Edition and Microsoft Windows Script Host Essentials.



Utilities Many utilities also expose a COM interface, which makes scripting possible. The Microsoft Windows Media™ Player is an example of such a utility. To find the possibilities for scripting these utilities, use the Object Browser and examine the object model for the program that you want to script. This shows you the object, methods, and properties that you can use in your scripts.
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Lab 2: Working with Objects Topic Objective



To introduce the lab.



Lead-in



In this lab, you will write scripts that interact with objects.



*****************************ILLEGAL FOR NON-TRAINER USE*****************************



Objectives After completing this lab, you will be able to: 



Manipulate the scripting object model by using Visual Basic Scripting Edition.







Manipulate the WSH object model by using VBScript.







Automate Microsoft Office applications by using VBScript.



Scenario In this lab, you will use VBScript to manipulate various object models. Specifically, you will instantiate objects from the scripting object model, the WSH object model, and the Microsoft Word object model. You will then manipulate the methods and properties of these objects to perform administrative tasks.



Estimated time to complete this lab: 45 minutes
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Exercise 1 Manipulating the Scripting Object Model In this exercise, you will write code in Visual Basic Scripting Edition that manipulates the scripting object model. You will instantiate a FileSystemObject object and a Folder object and manipulate them by using their methods and properties.



 To open a partially completed script file 1. Click Start, point to Programs, point to SAPIEN Technologies, Inc., and then click PrimalSCRIPT 2.0. PrimalSCRIPT appears. 2. In the PrimalSCRIPT 2.0 dialog box, click OK. 3. On the File menu, click Open. 4. In the Open dialog box, browse to the install_folder\Labs\Lab02\Starter folder (install_folder is C:\ Program Files\MSDNTrain\2433A by default). 5. Click ScrOM.vbs, and then click Open.



 To instantiate scripting objects 1. Locate the comment TODO Instantiate a FileSystemObject. 2. On the line immediately below this comment, type the following: Set oFSO = CreateObject("Scripting.FileSystemObject")



3. Locate the comment TODO Instantiate a Folder Object. 4. On the line immediately below this comment, type the following: Set oFolder = oFSO.GetFolder("C:\WINNT")



 To retrieve scripting object properties 1. Locate the comment TODO Retrieve the Drive property of the Folder object. 2. Add the following code to the end of the line immediately below this comment: & oFolder.Drive



You have now concatenated the drive property of the Folder object to a string literal. The script written in VBScript joins them together and then uses them as a parameter for the WScript.Echo method. The whole line of code should read: WScript.Echo "The Folder's Drive is: " & oFolder.Drive
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3. Locate the comment TODO Retrieve the Path property of the Folder object. 4. Add the following code to the end of the line immediately below this comment: & oFolder.Path



You have concatenated the path property of the Folder object to a string literal. The script written in VBScript joins them together and then uses them as a parameter for the WScript.Echo method. The whole line of code should read: WScript.Echo "The Folder's Path is: " & oFolder.Path



5. Locate the comment TODO Retrieve the Count property of the Folder object's Subfolders collection. 6. Add the following code to the end of the line immediately below this comment: & oFolder.SubFolders.count & " subfolders"



You have concatenated the Count property of the Folder object’s SubFolders collection to two string literals. The script written in VBScript joins them together and then uses them as a parameter for the WScript.Echo method. The whole line of code should read: Wscript.Echo "The Folder has " & oFolder.SubFolders.Count & " subfolders"



Tip The line continuation character () indicates that the text following it should be written on the same line as the code that precedes it. 7. On the File menu, click Save. 8. On the Script menu, click Run Script. 9. Review the message boxes as your script runs. You have now successfully manipulated the scripting object model.
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Exercise 2 Manipulating the WSH Object Model In this exercise, you will write code in Visual Basic Scripting Edition that manipulates the WSH object model. You will instantiate a Shell object and a Network object and manipulate them by using their methods and properties.



 To open a partially completed script file 1. On the File menu, click Open. 2. In the Open dialog box, browse to the install_folder\Labs\Lab02\Starter folder. 3. Click WSHOM.vbs, and then click Open.



 To instantiate and manipulate the Shell object 1. Locate the comment TODO Instantiate a Shell object. 2. Type the following code on the line immediately below this comment: Set oShell=WScript.CreateObject("Wscript.Shell")



3. Locate the comment TODO Use the Shell's RegRead method to read values from the Registry. 4. Type the following lines of code immediately below this comment: sOS = oShell.RegRead("HKLM\Software\Microsoft\ Windows NT\CurrentVersion\ProductName") nBuildNo = oShell.RegRead("HKLM\Software\Microsoft\ Windows NT\CurrentVersion\CurrentBuildNumber") sOrg = oShell.RegRead("HKLM\Software\Microsoft\ Windows NT\CurrentVersion\RegisteredOrganization")



These three lines of code retrieve data from the registry and store them in VBScript variables. Note There are only three lines of code for you to type. The continuation arrows indicate that the subsequent code should be typed on the same line as the preceding code. For more information about variables, see Module 3, “Script Logic,” in Course 2433A, Microsoft Visual Basic Scripting Edition and Microsoft Windows Script Host Essentials.
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 To instantiate and manipulate the Network object 1. Locate the comment TODO Instantiate a Network object. 2. Type the following code on the line immediately below this comment: Set oNetwork = CreateObject("WScript.Network")



3. Locate the comment TODO Map z: to the LabShare folder on the instructor machine (London). 4. Type the following code on the line immediately below this comment: oNetwork.MapNetworkDrive "z:", "\\London\LabShare"



5. On the File menu, click Save. 6. On the Script menu, click Run Script. 7. Review the message boxes as your script runs. 8. Using Windows Explorer, verify that your Z drive has been successfully mapped to the LabShare folder on the Instructor computer. You have now successfully manipulated the WSH object model.
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Exercise 3 Automating Microsoft Word In this exercise, you will write code in Visual Basic Scripting Edition that manipulates the Microsoft Word object model. You will instantiate an Application object. You will create and modify a Document object. You will then save the Document object and review its contents.



 To create a new script file 1. Switch to PrimalSCRIPT. 2. On the File menu, click New. 3. In the New dialog box, click VBScript, and then click OK. Note that PrimalSCRIPT enters some comments into the file for you. 4. On the Edit menu, click Select all, and then press DELETE.



 To automate Microsoft Word 1. Type the following lines of code: Dim wApp, wDoc, wRange, sName, sDate, sTime Set wApp = CreateObject("Word.Application") Set wDoc = wApp.Documents.Add Set wRange = wDoc.Range sName = "VBScript Student" sDate = Date() sTime = Time() sContent = "Document created by " & sName & " at " & sTime & " on " & sDate & "!" wRange.Style = -3 wRange.Font.Color = 255 wRange.Text = sContent wDoc.SaveAs "C:\Automating Word.doc" wApp.Quit Set sRange = Nothing Set wDoc = Nothing Set wApp = Nothing WScript.Echo "Your Document has been saved as C:\Automating Word.doc"
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Tip This code uses the following three objects from the Microsoft Word object model: • An Application object, which is Microsoft Word itself • A Document object that is saved to the hard disk • A Range object that allows the text of a document to be manipulated Note that the value -3 indicates a Microsoft Word style of Heading 2 for the Range object. Also note that the value 255 indicates that the text is red. All of this information can be obtained by using the Object Browser. 2. On the File menu, click Save As. 3. Go to the install_folder\Labs\Lab02\Starter folder. 4. In the File name box, type WordOM.vbs and then click Save. 5. On the Script menu, click Run Script. 6. You are notified that your document has been saved. Click OK.



 To review the results of your script 1. Using Windows Explorer, go to the root of your C drive. 2. Click Automating Word.doc, and then press ENTER. 3. Review the contents of the document, and then close Microsoft Word. You have now successfully manipulated the Microsoft Word Object Model.
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Review Topic Objective



To reinforce module objectives by reviewing key points



Lead-in



The review questions cover some of the key concepts taught in the module.







Object Terminology







Creating and Using Objects







Understanding Object Models







Common Object Models



*****************************ILLEGAL FOR NON-TRAINER USE***************************** 1. What is missing from this line of script? MyFSO = CreateObject(“Scripting.FileSystemObject”)



The Set keyword at the beginning of the line.



2. What ADSI provider is used to access the Active Directory? LDAP.



3. What protocols does the Cdosys.dll allow scriptable access to? SMTP and NNTP.



4. What object model provides access to the Windows Shell and Network objects? The WSH object model.
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PRA BIZ MODULE 2 
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Daprati (2006) How we interact with objects 

May 4, 2006 - The latter aspect is linked to sensitivity to both low-level (i.e. geometry), and high-level object 'affordances' (i.e. mechanical properties), which.
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m2 module 2 

1. L'office de tourisme est en face de l'aquarium. 2. Le camping municipal du soleil est à côté du musée des automates. 3. Le parc animalier est à deux rues de ...
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MODULE 2 Achat Revente.pptx 

signez le compromis. * C'est négociable. * De manière générale : * Quand on achète, on veut qu'il soit bas. * Quand on vend, on veut qu'il soit haut ...
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Fasse (2000) Haptic interaction with virtual objects 

man (or at least the M.I.T. student!) is cognitively a .... handed subjects; seven were male, one was female. ... All experiments were performed using a man-.
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Concrete proofs with abstract objects in modern 

in order to get a concrete result when dealing with a commutative ring see what happens after ... Dimension of Boolean valued lattices and rings. J. Pure Appl.
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Working T13 Draft 1153D .fr 

Oct 30, 1997 - "subscribe T13 [your email address]". Internet address for ... Added ATA/ATAPI-4 revision 6 to revisions list in IDENTIFY DEVICE response.
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